
Red Hat CloudForms 文档团
队

Red Hat CloudForms
4.1
在 Red Hat Enterprise Linux
OpenStack 平台上安装 Red Hat
CloudForms

如何在 Red Hat OpenStack 平台环境中安装和配置 CloudForms
Management Engine 应用





Red Hat CloudForms 4.1 在 Red Hat Enterprise Linux OpenStack 平台上安
装 Red Hat CloudForms

如何在 Red Hat OpenStack 平台环境中安装和配置 CloudForms
Management Engine 应用

Red Hat CloudForms 文档团队
cloudforms-docs@redhat.com



法律通告法律通告

Copyright © 2017 Red Hat, Inc.

The text of and illustrations in this document are licensed by Red Hat under a Creative Commons
Attribution–Share Alike 3.0 Unported license ("CC-BY-SA"). An explanation of CC-BY-SA is
available at
http://creativecommons.org/licenses/by-sa/3.0/
. In accordance with CC-BY-SA, if you distribute this document or an adaptation of it, you must
provide the URL for the original version.

Red Hat, as the licensor of this document, waives the right to enforce, and agrees not to assert,
Section 4d of CC-BY-SA to the fullest extent permitted by applicable law.

Red Hat, Red Hat Enterprise Linux, the Shadowman logo, JBoss, OpenShift, Fedora, the Infinity
logo, and RHCE are trademarks of Red Hat, Inc., registered in the United States and other
countries.

Linux ® is the registered trademark of Linus Torvalds in the United States and other countries.

Java ® is a registered trademark of Oracle and/or its affiliates.

XFS ® is a trademark of Silicon Graphics International Corp. or its subsidiaries in the United States
and/or other countries.

MySQL ® is a registered trademark of MySQL AB in the United States, the European Union and
other countries.

Node.js ® is an official trademark of Joyent. Red Hat Software Collections is not formally related to
or endorsed by the official Joyent Node.js open source or commercial project.

The OpenStack ® Word Mark and OpenStack logo are either registered trademarks/service marks
or trademarks/service marks of the OpenStack Foundation, in the United States and other countries
and are used with the OpenStack Foundation's permission. We are not affiliated with, endorsed or
sponsored by the OpenStack Foundation, or the OpenStack community.

All other trademarks are the property of their respective owners.

摘要摘要

本指南提供了如何在 Red Hat OpenStack 环境里安装和配置 Red Hat CloudForms 的说明。
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1. 安装 RED HAT CLOUDFORMS

Red Hat CloudForms Management Engine可以用一些快速步骤进行安装和配置。从 Red Hat 客户门户网站将
Red Hat CloudForms Management Engine 作为虚拟机映像下载后，安装过程将指引您上传应用至支持的虚拟
化平台或云供应商。

重要重要

在安装 Red Hat CloudForms 应用后，必须为 Red Hat CloudForms 配置数据库。详情请参
考第 2.3 节 “配置 Red Hat CloudForms 的数据库”。

1.1. 获取 Red Hat CloudForms 应用

1. 访问 access.redhat.com，并用您的客户帐号登录红帽客户门户网站。

2. 点击菜单条中的 下下载载。

3. 点击 A-Z 将产品下载按字母排序。

4. 点击 Red Hat CloudForms 访问产品下载页面。默认情况下都会显示最新的版本。

5. 从安装程序和映像的 Product Software里，选择 CFME OpenStack Virtual Appliance 并点击
Download Now。

1.2. 上传应用至 OpenStack

登录 OpenStack 仪表板以上传 Red Hat CloudForms 应用。

1. 登录 OpenStack 仪表板。

2. 在 Project 标签页里，进入 Compute → Images。

3. 点击创创建建镜镜像像。

4. 在 Name 里，输入映像的名称。

5. 从 Image Source 列表里，选择 Image Location。请注意目前只支持通过 HTTP URL 可用的映像。

6. 在 Image Location 里，添加一个外部的 HTTP URL 来加载映像。例
如，http://example.com/image.iso。

7. 从 Format 列表里，选择映像格式。例如 ISO - Optical Disk Image。

8. 指定 Architecture。例如，用于 32 位架构的 i386 或 64 位架构的 x86-64。

9. 将 Minimum Disk (GB) 和 Minimum RAM (MB) 字段留空。

10. 勾选 Public 复选框，让应用对于所有用户可用。

11. 勾选 Protected 复选框来防止映像被意外删除。

12. 点击创创建建镜镜像像。

Red Hat CloudForms 4.1 在在 Red Hat Enterprise Linux OpenStack 平台上安装平台上安装 Red Hat CloudForms
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你已成功地上传了 Red Hat CloudForms 应用。

应用映像被置于要上传的队列里。在映像的状态从 Queued 变为 Active 之前，这可能需要一些时间。

1.3. 在安全组里添加规则

安全组指定哪些 IP 通讯可以到达它的公共 IP 地址上的实例。安全组规则是在网络通讯到达客户内部自己定义
的防火墙规则之前被处理的。

注意注意

在默认的配置里，默认的安全组接受来自默认源的所有连接；默认组里的所有实例都可以在任意端
口彼此通讯。

1. 从 OpenStack 仪表板里，选择 Project → Compute → Access & Security。

2. 进入默认安全组的 Security Groups → Manage Rules。

3. 点击 Add Rule.

1. 安装安装 RED HAT CLOUDFORMS
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4. 配置规则。

a. 选择 Rule → Custom TCP Rule。

b. 选择 Direction → Ingress。

c. 从 Open Port 列表选择 Port。

d. 在 Port 字段里指定 443。

e. 从 Remote 列表里选择 CIDR。

f. 在 CIDR 字段里指定 0.0.0.0/0。

g. 点击添加添加。

1.4. 为 Red Hat CloudForms 创建自定义的 Flavor

Flavor 是一个资源分配配置集，例如，它指定可以分配多少个虚拟 CPU 以及多少内存给某个实例。您可以在
Red Hat OpenStack 用 m1.large Flavor 运行 Red Hat CloudForms，这个 Flavor 指定 4 个内核、8GB 内存及
80GB 磁盘空间。创建 Flavor 来运行 Red Hat CloudForms 是可选的。

下面的过程演示了根据最小要求（4 个内核、6GB 内存及 40GB 磁盘空间）创建 Red Hat CloudForms
Flavor。关于 Flavor 的更多信息，请参考《Red Hat Enterprise Linux OpenStack Platform 管理用户指南》。

1. 以 admin 登录 OpenStack 仪表板。

2. 在 Admin 标签页里，进入 System → Flavors。

3. 点击 Create Flavor 显示 Create Flavor 对话框。

4. 配置设置来定义满足 Red Hat CloudForms 系统要求的 Flavor。

a. 输入 Flavor 的名称。

b. 输入下列设置：

VCPUs: 4

RAM MB: 6144

Root Disk GB: 45

Ephemeral Disk GB: 0

Swap Disk MB: 0

5. 点击 Create Flavor。

Red Hat CloudForms 专有的新的 Flavor 将被创建。

1.5. 启动 Red Hat CloudForms 实例

1. 从 OpenStack 仪表板里，选择 Project → Compute → Instances。

2. 点击启动实启动实例例。

Red Hat CloudForms 4.1 在在 Red Hat Enterprise Linux OpenStack 平台上安装平台上安装 Red Hat CloudForms
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3. 输入实例的名称。

4. 为您的实例选择自定义 Flavor。它确定了您的实例的可用计算资源。这个 Flavor 使用的资源显示在
Flavor Details 面板里。

5. 在 Instance Count 字段输入 1。

6. 从 Instance Boot Source 列表里选择引导选项：

Boot from image - 显示一个新的 Image Name 字段。从下拉列表里选择映像。

Boot from snapshot - 显示一个新的 Instance Snapshot 字段。从下拉列表里选择快照。

Boot from volume - 显示一个新的 Volume 字段。从下拉列表里选择卷。

Boot from image (creates a new volume) - 从映像引导并选择卷的 Device Size 和 Device
Name 来创建一个卷。一些卷可以是永久的。要确保实例被删除时卷也被删除，请选择 Delete on
Terminate。

Boot from volume snapshot (creates a new volume) - 从卷快照引导，从下拉列表选择
Volume Snapshot 并添加 Device Name 来创建新的卷。一些卷可以是永久的。要确保实例被删
除时卷也被删除，请选择 Delete on Terminate。

7. 点击 Networking，并在 Available Networks 点击 + 按钮为实例选择网络。

8. 点运运行行。

1.6. 添加浮动 IP 地址

当您创建实例时，Red Hat Enterprise Linux OpenStack 平台会自动分配实例所属网络里的一个固定 IP 地址。
这个 IP 地址会永久地和实例关联，直至实例被终止。

除了固定 IP 地址外，您也可以为实例分配浮动 IP 地址。不像固定 IP 地址，不管涉及的实例的状态是什么，
您都可以在任何时候修改浮动 IP 地址的关联。

1. 在 RHEL OpenStack 平台主机的命令行里，用 nova-manage floating create 命令创建一个浮
动 IP 地址池。用 CIDR 标注里表达的 IP 地址块替代 IP_BLOCK。

$ nova-manage floating create IP_BLOCK

2. 在 Project 标签页里，进入 Compute → Access & Security。

1. 安装安装 RED HAT CLOUDFORMS
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3. 点击 Floating IPs → Allocate IP To Project。Allocate Floating IP 窗口将被显示。

4. 点击 Allocate IP 从池里分配浮动 IP 地址。分配的 IP 地址将出现在 Floating IPs 表里。

5. 从 Floating IPs 表里选择新分配的 IP 地址。点击 Associate 为专有的实例分配 IP 地址。

6. 选择要关联浮动 IP 地址的实例。

7. 点击 Associate 将IP 地址和所选的实例进行关联。

注意注意

当不再需要浮动 IP 地址时，如果要取消它和实例的管理，点击 Release Floating IPs。

2. 配置 RED HAT CLOUDFORMS

虽然 Red Hat CloudForms 已预先配置，可以立即集成到您的环境里，但您也可以根据需要修改其配置。

Red Hat CloudForms 4.1 在在 Red Hat Enterprise Linux OpenStack 平台上安装平台上安装 Red Hat CloudForms
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注意注意

Red Hat CloudForms Management Engine 应用希望具有最少的配置选项。

2.1. 修改配置设置

这个过程描述了如何修改 Red Hat CloudForms Management Engine 应用的配置设置。

1. 在启动应用后，请用用户名 root 和默认密码 smartvm 登录。这会显示 root 用户的 Bash 提示符。

2. 输入 appliance_console 命令。此时会显示 Red Hat CloudForms 工具概述页面。

3. 按 Enter 手动地配置设置。

4. 选择您要修改的项目编号，然后按 Enter。和您的选择相关的选项将被显示。

5. 按照提示进行修改。

6. 如适用则按 Enter 接受设置。

注意注意

在不活动超过 5 分钟后，Red Hat CloudForms 工具控制台会自动登出。

2.2. 高级配置设置

在登录后，您可以使用下类菜单项配置高级选项：

通过 设设置置 DHCP 网网络络配置配置 使用 DHCP 获取您的 Red Hat CloudForms 应用的 IP 地址和网络配置。应用初
始是配置为使用过桥网络的 DHCP 客户端。

如果在 Red Hat CloudForms 工具中使用的具体 IP 地址和网络设置，则可以使用 设设置静置静态态网网络络配置配置。

使用 测试测试网网络连络连接接 功能检查名称解析是否正常工作。

使用 设设置主机名置主机名 功能指定 Red Hat CloudForms 应用的主机名。

重要重要

智能状态分析正常运行要求 Red Hat CloudForms 应用拥有有效的全限定主机名。

使用 设设置置时时区、日期和区、日期和时间时间 功能配置 Red Hat CloudForms 应用的时区、日期和时间。

使用 根据根据备备份恢复数据份恢复数据库库 功能从之前的备份恢复 VMDB 数据库。

使用 设设置数据置数据库库区域区域 功能创建用来进行 VMDB 复制的区域。

使用 配置数据配置数据库库 功能配置 VMDB 数据库。在第一次安装和运行后请使用这个选项配置数据库。

使用 扩扩大大临时临时存存储储 功能添加临时存储空间。该工具格式化附加到工具中的未分区磁盘，并将其挂载至 
/var/www/miq_tmp。该工具使用这个临时存储目录执行某些映像下载功能。

使用 配置外部配置外部认证认证 (httpd) 体内通过 IPA 服务器配置验证。

2. 配置配置 RED HAT CLOUDFORMS
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使用 生成自定生成自定义义加密密加密密钥钥 功能重新生成用于加密明文密码的密钥。

使用 通通过过 SCAP 配置配置强强化化该该工具工具  功能，在该功能工具中应用安全内容自动化协议 (SCAP) 标准。您可以
在 /var/www/miq/lib/appliance_console/config/scap_rules.yml 文件中查看这些 SCAP 规
则。

使用 停止服停止服务务器器进进程程 功能停止所有服务器进程。您可能需要在性能维护后再进行此操作。

使用 启动启动服服务务器器进进程程 功能启动服务器。您可能需要在性能维护后再进行此操作。

使用 重重启应启应用用 功能重启 Red Hat CloudForms。您可以重启应用并清除日志，或者只是重启应用。

使用 关关闭应闭应用用 功能关闭应用并退出所有进程。

使用 概述信息概述信息 功能返回 Red Hat CloudForms 应用网络概述页面。

使用 退出退出 功能离开 Red Hat CloudForms 应用控制台。

2.3. 配置 Red Hat CloudForms 的数据库

在使用 Red Hat CloudForms 之前，请配置数据库选项。 Red Hat CloudForms 提供了两个数据库配置选项：

安装内部 PostgreSQL 数据库至应用里

配置应用以使用外部的 PostgreSQL 数据库

2.4. 配置内部数据库

重要重要

在安装内部数据库之前，请添加一个磁盘到容纳应用的基础架构里。关于如何添加磁盘的说明，请
参考您的基础架构专有的文档。因为当虚拟机在运行时通常不能添加存储磁盘，Red Hat 推荐在启
动应用之前添加磁盘。Red Hat CloudForms 只支持在空白磁盘上安装内部 VMDB。如果磁盘不是空
白的，安装将会失败。

1. 启动应用并从您的虚拟平台或云供应商打开一个终端窗口。

2. 在启动应用后，请用用户名 root 和默认密码 smartvm 登录。这会显示 root 用户的 Bash 提示符。

3. 输入 appliance_console 命令。此时会显示 Red Hat CloudForms 工具概述页面。

4. 按 Enter 手动配置设置。

5. 从菜单中选择 8) 配置数据配置数据库库。

6. 此时会提示您创建或获取加密密钥。

如果这是第一个 Red Hat CloudForms 工具，请选择 1) 创创建密建密钥钥。

如果这不是第一个 Red Hat CloudForms 应用，请选择 2) 获获取密取密钥钥，以便从远程主机获取密钥。
多区部署中的所有 Red Hat CloudForms 工具都必须使用相同的密钥。

7. 选择 1) 内部内部 作为数据库的位置。

8. 选择数据库的磁盘。例如：

Red Hat CloudForms 4.1 在在 Red Hat Enterprise Linux OpenStack 平台上安装平台上安装 Red Hat CloudForms
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1)  /dev/vdb: 20480

Choose disk:

输入 1 选择 /dev/vdb 作为数据库的位置。

9. 遇到提示时输入唯一的三位数字的区 ID 来创建新的区。

重要重要

创建新的区会破坏所选数据库上现有的所有数据。

10. 提示时确认配置。

Red Hat CloudForms 配置内部数据库。

2.5. 配置外部数据库

Red Hat CloudForms 数据库使用的 postgresql.conf 文件要求专门的设置方可正常运行。例如，为了改进
系统支持，就必须正确收回表空间、控制台会话超时、并格式化 PostgreSQL 服务器日志。基于有这些要求，
红帽建议：外部 Red Hat CloudForms 数据库采用由 Red Hat CloudForms 工具使用，基于标准文件的 
postgresql.conf 文件。

确保让 postgresql.conf 中的设置适合您的系统。例如，根据容纳 PostgreSQL 实例的外部系统中可用的
实际存储数量自定义 shared_buffers 设置。此外，可能需要修改 max_connections 设置，具体要看预
期连接到 PostgreSQL 实例的工具数量。

因为 postgresql.conf 文件控制单个 PostgreSQL 实例管理的所有数据库的操作，请不要将 Red Hat
CloudForms 数据库和单个 PostgreSQL 实例中的其他数据库类型混合。

注意注意

Red Hat CloudForms 4.x 要求使用 PostgreSQL version 9.4。

1. 启动应用并从虚拟化平台或云供应商打开一个终端控制台。

2. 在启动应用后，请用用户名 root 和默认密码 smartvm 登录。这会显示 root 用户的 Bash 提示符。

3. 输入 appliance_console 命令。此时会显示 Red Hat CloudForms 工具概述页面。

4. 按 Enter 手动配置设置。

5. 从菜单中选择 8) 配置数据配置数据库库。

6. 提示创建或获取安全密钥。

如果这是第一个 Red Hat CloudForms 应用，请选择创建密钥选项。

如果这不是第一个 Red Hat CloudForms 应用，请选择 从第一个 Red Hat CloudForms 应用提取密
钥的选项。多区部署中的所有 Red Hat CloudForms 应用都必须使用相同的密钥。

7. 选择 2) 外部外部 作为数据库位置。

8. 出现提示时输入数据库主机名或 IP 地址。

2. 配置配置 RED HAT CLOUDFORMS
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9. 输入数据库名称或默认留空（vmdb_production）。

10. 输入数据库名称或默认留空（root）。

11. 输入所选数据库用户的密码。

12. 提示时确认配置。

然后，Red Hat CloudForms 会配置外部数据库。

2.6. 为 Red Hat CloudForms 配置 Worker Appliance

您可以通过终端窗口配置工作节点应用。这些步骤演示了工作节点应用如何加入已有区域配置了数据库的应
用。

1. 启动应用并从您的虚拟平台或云供应商打开一个终端窗口。

2. 在启动应用后，请用用户名 root 和默认密码 smartvm 登录。这会显示 root 用户的 Bash 提示符。

3. 输入 appliance_console 命令。此时会显示 Red Hat CloudForms 工具概述页面。

4. 按 Enter 手动配置设置。

5. 从菜单中选择 8) 配置数据配置数据库库。

6. 此时会提示您创建或提取安全密钥。请选择 从第一个 Red Hat CloudForms 应用提取密钥的选项。多
区部署中的所有 Red Hat CloudForms 应用都必须使用相同的密钥。

7. 选择 2) 外部外部 作为数据库位置。

8. 出现提示时输入数据库主机名或 IP 地址。

9. 输入数据库名称或默认留空（vmdb_production）。

10. 输入数据库名称或默认留空（root）。

11. 输入所选数据库用户的密码。

12. 提示时确认配置。

3. 附加要求

3.1. 在 Red Hat CloudForms 上安装 VMware VDDK

在 VMware 环境里虚拟机上执行 SmartState Analysis 需要 Virtual Disk Development Kit (VDDK)。Red Hat
CloudForms 支持 VDDK 5.5。

1. 从 VMware 网站下载 VDDK 5.5（编写本书时的版本是 VMware-vix-disklib-5.5.0-
1284542.x86_64.tar.gz）。

Red Hat CloudForms 4.1 在在 Red Hat Enterprise Linux OpenStack 平台上安装平台上安装 Red Hat CloudForms
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注意注意

如果您还没有 VMware 的登录 ID，您需要创建一个。在编写本书时， 这个文件可以在
Downloads → All Downloads → Drivers & Tools → VMware vSphere → Drivers &
Tools里找到。展开 Automation Tools and SDKs 并选择 vSphere Virtual Disk 
Development Kit 5.5。或者，在 VMware 网站上使用 Search 来搜索这个文件。

2. 下载并复制 VMware-vix-disklib-5.5.0-1284542.x86_64.tar.gz 文件至应用的 /root 目
录。

3. 在应用里启动 SSH 会话。

4. 用下列命令解压并安装 VDDK 5.5：

# cd /root
# tar -xvf VMware-vix-disklib-5.5.0-1284542.x86_64.tar.gz
# cd vmware-vix-disklib-distrib
# /vmware-install.pl

5. 在安装过程中接受默认设置

安装 VMware VIX DiskLib API。您必须阅读和 VMware VIX DiskLib API 最终用户许可
证协议 才能继续。按 Enter 显示它。您接受吗? (yes/no) yes

您要用什么前缀来安装 VMware VIX DiskLib API? 这个前缀是其他文件夹如 man, bin, 
doc, lib 等放入的根目录。[/usr] (按 Enter)

用于 Linux 的 VMware VIX DiskLib API 5.5.0 build-1284542 已安装完成。您可以
在任何时刻通过下列命令删除这个软件：
"/usr/bin/vmware-uninstall-vix-disklib.pl". Enjoy, --the VMware team

6. 运行 ldconfig 让 Red Hat CloudForms 查找最近安装的 VDDK 库。

注意注意

使用下列命令来列出 VDDK 文件及是否可被应用访问：

# ldconfig -p | grep vix

7. 重启 Red Hat CloudForms 应用。

VDDK 现已安装在 Red Hat CloudForms 应用上。这启用了应用上 SmartState Analysis Server 角色角色的使用。

3. 附加要求附加要求
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